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1 INTRODUCTION 

 

 
Installed on a ‘satellite’ workstation (or laptop), LiveText greatly extends 
the live production environment, providing a new level of creativity, 
confidence, and professionalism! 
 
Users of compatible live production systems (like NewTek’s famous 
TriCaster™ family) are the primary beneficiaries.  LiveText multiplies 
creative opportunities and brings new depth to production capabilities. 
 

 

 
The LiveText system operator directly controls titling options for full pages, lower thirds, scrolls 
and crawls ‘on the fly’ -- without intruding into the live broadcast controlled by the TriCaster 
operator.  LiveText output can be previewed for director approval, or immediately displayed ‘on 
air. ‘  
 
LiveText offloads the creative and logistical burdens of titling during a live production to a 
dedicated operator.  The director is free to concentrate on the video production (with improved 
title accuracy as a side benefit.)  LiveText 2 also provides integrated DataLink™ support (allowing 
direct realtime links to many popular third-part sports game clock systems), as well as great new 
LiveTime™ clock/timer features.  In addition, LiveText allows export of various title pages file 
types for direct use in various NewTek live production systems. 
 

1.1.1 MANUAL ORGANIZATION 

 
While powerful, LiveText is quite intuitive.  If you have some basic familiarity with graphics 
applications, much of it will come naturally.  Or, if you’re familiar with the similar titling 
capabilities as a result of experience with other NewTek products, you’ll feel right at home. 
 

Chapter 2 (Getting Started) will help you install LiveText and connect to your live production 

network.  Next, in Chapter 3 (Titling Tools) you’ll explore LiveText’s title page creation and 

management tools.  Chapter 4 covers DataLink™ and LiveTime™, and Chapter 5 explains how to 

use LiveText titles in your live production environment (as well as other applications.)  

Appendices providing information on keyboard shortcuts and networking are followed by a 

keyword index. 
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2 GETTING STARTED 

 

 
This chapter will help you install, register and establish a network 
connection between LiveText™ and your (compatible) live production 
system. 
 
We will review recommended system specifications, installation and 
registration, networking procedures and connection troubleshooting. 
 

 

 

2.1 SYSTEM REQUIREMENTS 

 
LiveText requires (as a minimum): 
 

 A CPU which supports the SSE2 instruction set (typically an Intel® Core2® or better) 

 A graphics display card (PCI-E recommended) with Microsoft® DirectX® 9™ (or better) 
compatibility 

 A monitor capable of displaying a minimum resolution of 1280x800 pixels 

 2GB RAM (4GB or more preferred) 

 Gigabit network recommended for network transmission to supported live systems 
(TriCaster, VT[5]) 

 

2.2 INSTALLING LIVETEXT™ 

On launch, the LiveText installer presents various dialogs to ask you to accept the end user 

license agreement, confirm or modify various defaults (such as the program installation path) , 

and so on as it proceed..   

After installation the Registration dialog is presented, providing an opportunity to register your 

copy of LiveText and obtain the permanent unlock code required to operate it beyond the 14 day 

grace period.   
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2.2.1 STEP 1 

Read the End User License Agreement, 
and click to accept (or decline) before 
proceeding. 

 
 

2.2.2 STEP 2 

Click Next to accept the default 

installation location, or using the Browse 

button to modify the path where you wish 

LiveText’s program files to be installed on 

your system. 

 

Figure 1 

Figure 2 
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2.2.3 STEP 3 

If you wish to have a convenient Desktop 
or Quick Launch icon to launch LiveText, 
click the appropriate switches and click 
Next. 

 

2.2.4 STEP 4 

Review your previous selection, and then 

press Install. 

 

Figure 3 

Figure 4 
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2.2.5 STEP 5 

With Launch NewTek LiveText check-marked, 

click Finish to proceed to the Registration 

pane. 

 

2.2.6 STEP 6 

If your LiveText system is connected 

to Internet, you can click the “Click 

here” button to perform your 

LiveText registration online. 

Otherwise, note the Product ID 

shown in this panel and visit the 

registration web page as shown to 

register your software and receive 

your unlock code. 

At this point, you can begin to work 

with LiveText! 

 

Figure 5 

Figure 6 
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2.3 MAKING THE CONNECTION 

LiveText is designed to play an important role as an integral component in a live production suite.  

In this configuration, the LiveText workstation is connected to the live switching unit (such as a 

TriCaster™) across a network. 

A peer-to-peer network connection can be established between the two units using a crossover 

cable.  Often though, the LiveText workstation will be a client on a larger LAN (local area 

network), which network also includes the live production system.  (In this configuration, displays 

from additional networked systems may also be available to the live production system as video 

sources via NewTek’s iVGA utility.) 

Naturally, the existence of the network connection is critical if you wish to use LiveText in a 

‘direct-to-air’ application.  A ‘hard-wired’ Ethernet connection is preferred – and ‘the faster the 

better’ (Gigabit networking is strongly recommended, especially for more demanding use such as 

long animated scrolls or crawls. For HD sessions, it should be considered mandatory.)  

Note that the LiveText host and networked live production system must be on the same local 
subnet.  Also, if your LiveText host is protected by a firewall, you will need to either disable the 
firewall, or configure it to allow LiveText access to the network. 

Network throughput can be quite variable in some environments (such as a corporate or 

tradeshow network.)  To the extent you can ensure non-essential network traffic does 

not interfere with LiveText operation during live production, you will enjoy more peace of 

mind. 

In most cases, at this point your network connection is correctly established and you are ‘good to 
go.’  (If you should happen to run into a connection issue, see Appendix B – Networking Notes for 
information on diagnosing network problems).  
 
Otherwise, you can skip right to the next chapter – Titling Tools. 

Performance Note: Realtime playback depends on several factors. For example, 

previewing a scroll in the edit window could cause another scroll playing Live to skip on 

some systems. To be safe, it’s always wise to test prior to important live events. 
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2.4 A SIMPLE EXAMPLE 

Let’s try creating a simple title page: 

 

 

Figure 7 

1. Click the T in Text and Drawing, then click in the Canvas to set the insertion point 

 

2. Type “LiveText”, press Enter, then type “Productions” 

 

 

Figure 8 
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3. Click the Arrow (Select) button, and drag out a box (marquee) to surround both lines of 

text on the Canvas, selecting them (Figure 8). 

 

 

Figure 9 

4. Click the Style tab (below the Canvas), and then click thumbnail number 4 in the Styles 

bin area.  This will immediately add color and beveling to the (selected) text you entered 

previously. 

 

 

Figure 10 
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5. Click the View tab, and turn on Safe Area, to help compose your page 

 

 

Figure 11 

 

6. Next, click both the Vertical and Horizontal Center buttons in the Alignment section of 

the Tool Panel, centering the text on the Canvas. 

 

 

Figure 12 

7. With both lines of text still selected, click Group (in the Alignment section) to link them 

together 

 

8. Then drag a corner point of the grouped text to make it larger (use your judgment, using 

the Safe Area overlay as a guide – the inner rectangle denotes the traditional ‘text safe’ 

margin.) 
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Figure 13 

9. Click the Filled Rectangle button in Text and Drawing 

 

 

 

Figure 14 

10. Click thumbnail number 6 in the Styles tab, and drag out a rectangle in the Canvas that 

completely covers your text. 

 

 

Figure 15 
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Figure 16 

11. Select the rectangle (using the Arrow tool), and click Send Backward in the Alignment 

section 

 

 

Figure 17 

12. Go on to adjust Tracking, Leading in the tabbed Text and Drawing controls beneath the 

Canvas, and finish up by adding a Shadow to your text 

 

 

 

 

 

 Figure 18 
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2.5 USING PAGE TEMPLATES 

A large number of gorgeous and very useful Page Templates are included with LiveText, to speed 

you on your way.  You can easily modify these to suit your own production designs. 

 

Figure 19 

1. Select Add Page from the drop-down menu in the Pages panel at right (Figure 19). 

 

2. As you slide your mouse down the list, notice that a thumbnail fly-out keeps pace 

showing a preview for each template. 
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3. Select Emerald 1, loading that template into the Canvas for modifications 

 

 

Figure 20 

4. Click the T button (Text)  in the Text and Drawing control panel at upper-left, and 

slide you mouse around over the text fields in the Canvas 

 

5. Notice that a black outline surrounds each text line in turn.  Select the text inside 

one of these outlines, and change it to suit your need. 

 

        Figure 21 

Congratulations, with LiveText you’re a CG artist.  Could it be any easier?  
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3 TITLING TOOLS 

 

 
Designing and managing great looking still and animated text and 
graphics for your productions is easy with LiveText. It’s deep 
professional character generation tools will provide a clean, professional 
looking result you’ll be proud to broadcast! 
 
 

 

 

3.1 LIVETEXT OVERVIEW 

The main panel is dominated by the 

large cental Canvas, which provides an 

interactive display of the current project 

page. 

The column at left is a Tool Panel for 

creating and editing visual elements, 

including text.  LiveText’s File menu is 

above this column. 

The Motion Panel is located just below 

the Canvas.  It permits you to create 

animated scrolls or crawls. 

Right beneath the Motion Panel is the 

tabbed Control Panel, which gives you 

control over attributes of text and 

graphic objects. 

Finally, a column on right of the Canvas provides multi-page management (the Pages panel) of 

your project, file Load, Save and Export functions, and at the top – the all important Live Preview 

pane. 

Figure 22 
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3.2 OUTPUT ASPECT (4:3 OR 16:9?) 

You may be wondering whether you need to consider the image aspect of your LiveText projects.   

LiveText 2.0 projects are effectively aspect independent.  The LiveText Canvas (canvas) where 

you prepare your title pages is always 16:9.  When connected to a compatible live broadcast 

system (such as TriCaster) over a network, the current LiveText output aspect is updated as 

required (from 4:3 to 16:9 or vice versa) to conform to the aspect of the live production system 

connected.  The current network output format is shown at upper-right in LiveText’s titlebar. 

When exporting title pages as bitmap (image) files for external use, you choose the resolution 
and image aspect from the export dialog.  When you opt for a 4:3 export only the corresponding 
center region of 16:9 title pages is exported.  (The Safe Area overlay has 4:3 page edge and text 
safe lines to make this easy to visualize.) 
 

3.3 PROJECT PAGE MANAGEMENT 

LiveText projects consist of one or more pages. If you want one main introductory title, another 

title for a station ID, an animated list of scrolling credits for the end, and so on – each of these is 

created as a separate page within the whole project. 

Completed pages may be exported (using 

Export Current Page or Export All Pages in 

the File menu) for use in other programs 

supporting (including TriCaster, VT[5] and 

SpeedEDIT) as image (.PNG) or animation 

(.avi) files, or as Title Pages (.cgxml) 

compatible with TriCaster TCXD systems.  

 

 

 

Entire projects can also be saved and re-loaded later, allowing you to work with one design for 

one production while a completely different look for another is only a few clicks away. 

Figure 23 
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Note: Project and page files (.cg files) created with earlier versions of LiveText came in 

4:3 and 16:9 formats.  If you load one of these older files into LiveText 2.0, you will be 

asked whether you wish to load it as 4:3 (centered on the page), or as 16:9 (filling the 

screen). 

3.3.1 THE PAGES PANEL 

The Pages panel at the right of the Canvas displays a thumbnail image of each page in the 

current project, and provides page management tools.  A new project will show one (empty) 

page.  When a project has multiple pages, the thumbnail for the one currently selected for 

editing in the Canvas is surrounded by a white border.    

A (red border) indicates the page currently assigned as LiveText’s Live output (if any). 

Jump to a specific page in your project by entering the page number in the Page field. Or you can 

cycle up or down through the pages by clicking on the neighboring arrow buttons.  Click a page 

thumbnail in the Pages panel to edit it (displaying it in the Canvas,) or double-click it to send it 

out Live. 

3.3.1.1 CLONE AND REMOVE 

Clicking the Clone button copies the currently highlighted page, inserting the copy below that 

page.  

Hint: Clone permits you to quickly and easily ensure pages conform to a particular 

graphic theme or format – just Clone an adequate number for you needs, then modify 

them individually. 

Clicking Remove deletes the currently selected page from the project (careful, there is no Undo 

for this action.) 

3.3.1.2 ADD PAGE 

You click the small arrow button beside Add Page to insert another page into your project.  New 

pages are added under the current page (and of course, they are not sent out as Live until you 

want them to be). 
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The drop-down menu reveals a number of types of pages you can add.  The uppermost choices 

represent new blank pages of various types. 

Hint: You can also quickly add blank pages simply by clicking repeatedly in an empty 

black area of the thumbnail column – each click adds one empty page. 

 This drop-down menu is home to a long list of professionally designed templates, ready and 
waiting for your modifications. As you scroll over the entries, a fly out thumbnail representation 
appears to make choosing something just right for your needs easy. 
 
 

 

Figure 24 

 

Hint: Another selection in the Add Pages menu permits you to “Add Page to Templates 

List.” This lets you store the currently highlighted pages as LiveText templates, for quick 

access and consistent styling using templates of your own design. 
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3.4 FILE MENU 

The File menu is in the upper-left corner of the LiveText desktop, and contains project and page 

file management tools.  These functions are considered in Chapter 5, Live Production and File 

Management.  

3.5 THE TOOL PANEL 

The Tool Panel situated left of the Canvas provides the basic tools to create the text and graphic 

elements of your title page compositions, establish their relationships to one another if any, and 

set their primary attributes. 

3.5.1 TEXT AND DRAWING 

T (Text) 

Click on the T (Text) button to activate the text function. Before you 

enter text, this button must be highlighted. Click in the Canvas and an 

I-beam icon starts blinking. This is your Canvas cursor. When you 

type, the I-beam is the insert point for the text. You can move the I-

beam anywhere on the Canvas by clicking it with your mouse and 

dragging it around or just clicking your mouse on another spot in the 

Canvas. 

To edit the characters of any existing text, click your cursor anywhere 

on the line of text, and drag your mouse to select letters or whole 

words (selected character will be highlighted.) 

 

Hint:  Use the End and Home keys on your keyboard to navigate to the 

beginning and end of text lines. If you mistyped, you can use the 

Backspace key to erase or the keyboard arrow keys to go back or 

forth on the line or up and down between lines. 

  

 

Figure 25 
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Arrow (Selection) 

Clicking on the Arrow button activates the Selection tool (and switches off the Text tool). This 

selects the whole line, not just parts of it. If you have just typed something in, clicking the Arrow 

will create a box around what you typed. Select the line by clicking anywhere on it. 

When you roll your mouse over the box, the cursor changes form. When it becomes a two-

headed arrow, you can click to grab an edge of the box and drag it in or out to resize the text. 

When the cursor sprouts four arrowheads, you can click and grab the whole box to move it 

around the Canvas.  Hold down the Shift key over a corner of a selected object and a curved 

arrow cursor indicates you may now drag to rotate it. 

3.5.1.1 GRAPHIC SHAPE TOOLS 

The area immediately below the Arrow and T(Text) buttons is 

home to a number of tools used to create shapes.  Each shape is 

initially a separate graphic object. 

The tools are very easy to use, and just as easy to edit at any time 

after their creation, whether simply to adjust their position, or to 

add or modify much more elaborate treatments. 

For the most part, shapes are easily created by clicking one of the 
buttons, and dragging the cursor in the Canvas.  The shape 
responds interactively to your movements, and is created when 
you release the mouse button. 

 
Line  
To make a straight line, you simply click in the Canvas where you want the line to begin and then 
drag the mouse to where you want the line to end. 
 
Rectangle 
The Rectangle button creates outlines of four-sided objects. 
 
Filled Rectangle 
This tool works just like the Rectangle tool except it fills in shape with the same color as the 
outline. 

Figure 26 
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Arc 
The second row contains variations of ellipses. With the first, you can create segments of arcs. 
Click the mouse in the Canvas and drag to establish the radius of the arc, releasing the button 
when you are happy.  Then click and drag again to define the extent of the arc.  Release the 
button to complete it. 
 
Oval  
The Oval works just like the Rectangle tool. Click and drag in the Canvas to draw out your shape. 
 
Filled Arc 
The Filled Arc operation is the same as the Arc tool (see above). The only difference is that the 
arc created is filled in. Think of the Filled Arc as the pie chart tool. 
 
Filled Oval  
This tool works like the Filled Rectangle. 
 
Spline  
This tool and its siblings create freeform spline curve shapes. Click in the Canvas and release the 
mouse to establish the starting point.  Move to another spot on the screen and click again to 
establish a second node though which the spline will pass.  Continue to add nodes until you are 
satisfied, then double-click to end the curve.   
 
Closed Spline  
The technique for the Closed Spline is similar to the Spline: click in the Canvas, release the 
mouse, move to the next spot and click again, etc... With this tool though, nodes are 
automatically connected to the first (anchor) point to create an enclosed object. When you’re 
finished, simply double-click. 
 
Closed Filled Spline 
This tool works just like the Closed Spline tool except it fills in shape with the same color as the 
outline.  
 
Polygonal Line 
 This tool functions like the Spline except it doesn’t create a curve between the nodes. You click 
in the Canvas to establish your anchor point, release the mouse and move to your next spot, and 
click to create a node. A straight line will connect the two points. Move and click again and a line 
will connect this point with the previous one. With this tool, a sharp angle is maintained at the 
intersection of the lines. You double-click at the last point to finish. 
 
Polygon 
 This tool works like the Polygonal Line, except as soon as you create the first node, it’s 
connected to the anchor point, automatically creating an enclosed object. 



 

22 

 
Filled Polygon 
 This tool works just like the Polygon tool except it fills in shape with the same color as the 
outline. 
 

 

 

Color - The large color well below the drawing tools permits you to set a base color for 

the objects you create using the tools.  Left click it to open the Color Picker panel, or right 

click and drag to use an eye dropper cursor to pick a color from the screen. 

Note: Extensive control over color is provided in the Color section of the tabbed Control 

Panel discussed a bit further on in this chapter. 

 

3.5.1.2 OBJECT MANAGEMENT 

Completing this section are essential basic editing tools: Cut, Copy, Paste, Delete, Undo, and 

Redo. The traditional Windows keyboard shortcuts also work: 

 

 

Figure 28 

 Cut — Ctrl + x 

 Copy — Ctrl + c 

 Paste — Ctrl + v 

 Delete — Delete key 

 Undo — Ctrl + z 

 Redo — Ctrl + y 

Figure 27 
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3.5.2 ALIGNMENT 

The alignment panel permits quick and easy positioning and re-ordering of objects on the 

Canvas. 

3.5.2.1 HORIZONTAL JUSTIFICATION 

The top row of buttons in this section control horizontal justification buttons, aligning text as are 

commonly found in word processing programs. 

 

Left Justify - aligns your text to begin just inside the left edge of 

the Text Safe Area 

Center - aligns the center of the line(s) with the center of the 

Text Safe Area. 

Right Justify - aligns your text so the end of the line(s) is just 
inside the right edge of the Text Safe Area. 
 
 
 
 

3.5.2.2 VERTICAL JUSTIFICATION 

Each of the buttons in the next row justifies your text within the vertical Safe Text area of the 

screen. 

Top - aligns your text just below the upper limit of the Text Safe Area. 

Center - centers your text vertically in the Text Safe Area. 

Bottom - aligns your text just above the lower limit of the Text Safe Area. 

3.5.2.3 DEPTH CONTROL 

Text and objects in the Canvas which occupy the same space are normally displayed in the order 

created – first items to the rear, as it were, with newer object in front.  The depth controls in this 

Figure 29 
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section permit you to modify this order.  Select an object (or line of text) and click once to move 

one step relative to other objects. 

Bring Forward – move the selected item forward 

Send Backward – move the selected item back 

Note:  The Layers section of the tabbed Control Panel (discussed in Section3.7.6) 

provides an alternative (and often more convenient method) of re-ordering objects and 

text. 

3.5.2.4 GROUP/UNGROUP 

 Even though each line of text and graphic object is really a separate entity, you can select 

multiple lines and Group them together to respond to modifications in unison.  

The UnGroup button undoes the union. Hold down the Ctrl key while clicking multiple items or 

lines of text and press the Group button. The bounding boxes are now replaced by a single 

bounding box. Hit UnGroup again, and the lines become separate entities once more. 

 

3.6 THE MOTION PANEL 

 

Figure 30 

The Motion Panel contains the tools to create both scrolls and crawls.  This is where you control 

the direction, speed and behaviors of your crawls and scrolls. 

 

The No Motion button and Direction arrows are self-explanatory. If you want a text crawl from 

left to right, pick the right pointing arrow. For a scroll moving up, choose the up arrow, etc. 
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3.6.1 SPEED CONTROL 

In the Motion Speed field, choose a specific rate of motion in units of ‘pixels per frame.’ 

Fun with math: For a text crawl across an NTSC format screen, knowing that the screen 

is 720 pixels and there are roughly 30 frames per second, you can readily work out a 

suitable value.  To have an object or text item crawl from one side to the other in four 

seconds, 720 divided by 120 (30 frames per each of the 4 seconds) equals 6. 

If motion pages move too quickly, motion may not appear smooth. A common preference is for a 

line of text to take about seven seconds to travel from the bottom of the screen to the top. You 

may wish to test the speed out on a TV monitor to see if it suits you. 

3.6.2 END BEHAVIOR 

The End Behavior setting in the Motion Panel determines what happens when an animated page 

runs its full course. 

 Over tells the CG to scroll or crawl the page once, and then stop when the page has left 

the screen. 

 Stop tells the CG to scroll or crawl the page once and then to hold on the last line of 

text. 

 Loop tells the CG to loop the page continuously. 

 Loop + Frame tells the CG to loop the page continuously and to place a blank frame 

between loop repetitions. 

3.7 CONTROL PANEL TABS 

 

Figure 31 

Near the bottom of the screen (beneath the Motion Panel) is the multi-tab Control Panel. The 

individual panels provide precise command of countless text and graphic object attributes, 

organization, and management. 
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3.7.1 VIEW 

 

Figure 32 

The View tab reveals three sections, Grid, Guides and Display.  These all add one or another type 

of overlay to the Canvas above, as an aid to composing your graphic and text pages on.  As you 

would expect, none of the overlay elements appear in the final output. 

GRID 

Define a grid to help you align objects on 

the Canvas in specific arrangements.   

The two numeric entry fields with 

associated mini-sliders adjust the width and 

height of cells in the grid.  

 

 

The Grid switch toggles the grid overlay on/off. Enabling Snap effectively makes the lines of the 

grid somewhat magnetic - you are not restricted to placing items exclusively along the grid lines, 

but the cursor is drawn toward them, making it easy to do so if you wish. 

GUIDES 

This feature is somewhat similar, in that it offers 

overlaid lines and a similar Snap feature.  However, 

rather than displaying a full grid, you define where the 

lines will go – add just one guide line, or as many as you 

like.   

 

To add a Guide, Rulers must be enabled in the Display section.  Click in the calibrated ruler 

display, (horizontal or vertical), and drag the cursor across the Canvas.  Release the mouse 

Figure 33 

Figure 34 
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button when the new Guide is positioned where you want it to go.  If you hover the cursor above 

a Guide, it becomes a double-headed arrow that you can drag change the Guide’s position. 

Use Clear Guides to remove all existing Guides from the screen. 

DISPLAY 

Traditional television displays crop the image area of 

video somewhat. 

For this reason, it’s customary to allow a certain 

amount of ‘safe area’ on the margins of the screen – 

to make sure that important text displays or action are 

not inadvertently cut off for viewers. 

 

The Safe Area switch in the Display pane enables an overlay on the Canvas.  The lines make it 

easy for you to create your title pages with these overscan limitations in mind.  Inner rectangles 

mark the 4:3 Text Safe area and outer boundaries, while the outermost lines show the edge of 

the entire 16:9 page. 

For very complex pages, it can be useful to enable the Wireframe switch.  While enabled, this 

removes opaque color from objects on the Canvas window, leaving only an outline through 

which other items can be seen. 

Checkerboard replaces the default black Canvas background with two-tone checks (these do not 

appear in exported title pages, of course).  Finally, the Rulers option provides another level of 

precision when preparing your title pages by adding calibrated scales to the display.  (And, as 

noted a moment ago, you add Guides to the Canvas using the Rulers.) 

3.7.2 TEXT AND DRAWING 

 

Figure 36 

This tab provides primary control over all text and graphic object attributes.   

Figure 35 
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3.7.2.1 FONT AND ORIENTATION 

FONT 

The drop-down Font menu allows you to choose from your installed typefaces.  Bold, Italic, and 

Underline buttons are to its right, along with another basic face color well. 

The Width and Height controls are locked proportionally when the neighboring Lock Aspect 

Ratio control is lit up. Rotate adjusts the exact degree of rotation (on the Z axis.) 

Tracking adjusts the amount of space between neighboring pairs of letters. 

Hint: You can also adjust tracking interactively in the Canvas.  Place the cursor between 

letters and hold down the Alt key while using the arrow keys to add or reduce spacing.  

Leading adjusts the amount of vertical space between text lines. Multi-select the lines you wish 

to adjust using CTRL + click (or by dragging a rectangle around them in the preview window), and 

raise or lower the Leading value to suit your need. 

ORIENTATION 

Rotate changes the orientation of text and 

drawing objects. Hold During Motion, when 

enabled, ensures that the selected object does 

not move as an element within Scroll or Crawl 

pages. Do Not Render prevents the image from 

being displayed as part of the page when 

displayed or rendered. 

ARC/LINE 

The Joint menu options affect way corners of a 

drawn CG object are created – choose from 

Round, Bevel, or Square. Similarly, the End menu 

selection determines whether the ends of a line object terminate in a Square, Round, or Point. 

 

Figure 37 
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Arc Start and End values permit great precision for Arc and Filled Arc objects, and the Thickness 

value is pretty much self-explanatory. 

EDGE 

Edge refers to a two-tone border that conforms to character or object shape.  The way corners 

are painted is controlled by the drop-down menu – options are Round, Square, or Bevel. 

The two boxes to the right of the menu are where you choose the colors for the inside and 

outside edges of the border applied around your objects.  Inside color is the box on the left, 

outside color is on the right. 

Click in the box to bring up the Color Picker panel, or right-click it to activate the Eyedropper tool 

to choose a color from the Canvas. 

SHADOW 

Shadow options include Cast, Drop, and Soft (the numeric Soft setting is only relevant to the 

latter.) 

The Italic setting permits you to shear the Shadow independent of the ‘shadow-casting’ object, 

and the X and Y fields control the amount of offset for the shadow. 

3.7.3 THE COLOR TAB 

The Color tab provides the control over characteristics for coloring and texturing objects, 

including text. 

 

Figure 38 

3.7.3.1 COLOR DESCRIPTION 

Use the Edit menu to specify which aspect of a text line or graphic object you intend to modify. 

There are three choices:  Fill controls colors used in the body of the font or object.  Choosing 

Edge or Shadow restricts modifications one of those characteristics.  
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Type permits you to choose between six different types of color (or image-based texture): 

Choosing Solid for Type applies a single color to the surface (the 

one in the neighboring Solid Color pane).  When you pick one of 

the middle four instead (Linear, Corners, Angle, or Radial), the 

current Gradient colors are applied. 

Linear (Type) applies the Gradient in a straight left-to-right 

pattern. Corners will apply the gradient color starting at the 

upper left corner diagonally, sweeping around to the bottom 

right.  Angle applies the Gradient starting at 3 o’clock and 

rotating counterclockwise.  

 

Radial applies the gradient starting at the center of the surface and emanating to the edge. 

Texture applies an image map (specified using the Image drop-down menu in the Solid Color 

Pane at right) to the surface. 

Adjusting the Rotate value changes the application angle for the gradient or texture, when 

active. 

SELECTION, LINE & CHARACTER  

If you have multiple lines of text on a page, you can choose how the 

color, gradient, or texture will be applied.   

Selection fits your settings to selected characters or objects (including 

multiple selections.)  Line applies them independently to each line of 

text, while Character applies the texture independently to each 

character. 

Note: In reality, each text line is always a separate object.  If you select just part of a text 

line (in the Canvas while in T(Text) mode (whether by dragging the mouse or using Shift 

with the arrows keys), and apply different settings, the line will split into two objects to 

accommodate your wishes.  You may want to use the Group function to permit you to 

continue treating the line as a single object subsequently. 

 

Figure 39 

Figure 40 
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3.7.3.2 THE GRADIENT PANEL 

The gradient panel provides awesome color control, allowing you to create and apply many 

beautiful effects.  

GRADIENT PRESETS 

The upper section of the Gradient 

Panel contains a goodly number of 

presets, represented visually. 

Scroll up and down through the 

selections using the arrow buttons at 

right, and simply click a gradient you 

like to activate it (replacing the 

content of the gradient edit pane 

below.)   

 

Use Add to send the current gradient to the presets list, or Remove to clear a preset. 

The dotted vertical lines in the gradient preview pane mark the nodes of specific color values 

that define the gradient.  You can drag these left or right interactively, or select one by clicking 

directly on it, and Move it using the mini-slider control at right.  The display updates immediately 

to show the results of the changes you make. 

Add a new node by double-clicking in the gradient preview.  Delete a selected node using the 

Delete button, and set its color using the Node Color well.  You can also separately adjust the 

Bright(ness) of nodes using the mini-slider at right. 

To multi-select nodes for certain operations, you can click them one at a time with the Ctrl key 

depressed or drag out a marquee around them right in the editor (a shaded box shows the 

selection zone in this case.)  With one or more nodes selected, each time you drag the Clone 

slider, another set of duplicate nodes is created. You can also clone one or more nodes by 

holding down Ctrl and dragging left or right in the gradient preview pane.  Scale expands or 

contracts the distance between multi-selected nodes. 

Figure 41 
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Clear Gradient lets you start fresh, while Loop Gradient allows the gradient to repeat itself, so 

that the color at one end loops seamlessly to the opposite end (this control has no effect when 

nodes exist at each end of the gradient.) 

3.7.4 THE STYLE TAB 

 

Figure 42 

The Style tab allows you to add gorgeous and complex treatments to your text and graphic 

objects with a single click.  It is also a great way to ensure consistency for the title slates you use 

in your productions! 

To apply a Style preset, simply select a line of text or an object in the Canvas, and then click a 
representative thumbnail in the Styles pane.  Create your own custom look, and add it to the 
Styles list using Add, and of course, remove those you don’t care for using Delete. 

3.7.5 THE FILEBIN 

You can drag image, .cg or .TXT file icons right onto the Canvas directly from this Filebin.  

(Loading a .CG file in this manner replaces the current project.) 

 

Figure 43 
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Above the file window is a menu with navigation and file management buttons at left, and a file 

icon preference menu at right.  More detail on the various features of the Filebin can be found in 

Chapter 5, Live Production and File Management. 

3.7.6 THE LAYERS TAB 

The Layers tab provides a convenient way to modify the depth of various text and CG objects on 

the Canvas, as well align objects relative to one another. 

 

Figure 44 

At times the Canvas can become rather cluttered, making it tricky to select text lines or objects 

directly by clicking.  The final tab provides a convenient alternative. Each item in your current 

page is represented by an individual line in the Layers panel. 

Consider the situation at left, which 

shows a line of text which is 

unfortunately occluded by a rectangle 

object. 

Re-ordering layers is a simple matter in 

the Layers panel. 

 

 
Figure 45 
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Figure 46 

Simply drag the line for the rectangle above the text line with the mouse.  The insertion point 

where the current selection will be dropped when you release the mouse is shown by a thick 

white line. 

Objects nearest the top of the list will appear 

further back in the result – appearing behind 

objects that appear lower down in the Layers 

list. 

 

 

Multi-select objects by dragging a box around them in the Canvas window; then just click a 

button in the Align section to line them up.  

The last object selected will be brightly highlighted in the Layer panel, and will be the 

one that other objects align to. 

 

3.8 OPTIONS AND KEYBOARD CONTROL 

An extensive list of Keyboard Shortcuts is available (for example, pressing Alt + s toggles the Safe 

Area overlay in the Canvas on and off.)  Press F1 to view shortcuts (please see also Appendix A – 

Keyboard Shortcuts). 

Figure 47 
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4 DATALINK™ AND LIVETIME™  

 

 
DataLink™ provides users of NewTek’s TriCaster™ and VT*5+™ live video 
production systems the ability to display dynamically updated data from 
a variety of external sources. 
 
Supported data sources include several third-party sports scoreboard 
systems, plus two common file types – standard ASCII text files and SQL 
database files.  In addition, LiveText ‘s native LiveTime™ allows users to 
embed realtime clock and date displays in title pages. 
 

 

Together, the combined features of DataLink and LiveTime allow you to prepare and display title 

pages that containing score, time or various other data types (including images) from both 

internal and external sources, and update these in realtime. 

 

Figure 48 

Three different DataLink modules continually monitor data from their respective sources as 

follows: 

 The Scoreboard Linker monitors a data feed from external hardware scoreboard 

controllers (typically found in sports venues). 

 The TXT Linker draws values from specified ASCII text files. 
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 The Database Linker provides allows the use of MySQL database functions, and even 

supports data accessed across a network. 

LiveTime brings additional capabilities, using the LiveText host’s internal system clock to supply 

time displays embedded in title pages. 

Sections of this chapter displaying the scoreboard icon (seen at left) are of 
special interest to users who plan to connect their LiveText system to a 
supported external hardware scoreboard controller.  

 

4.1 DATALINK OVERVIEW 

4.1.1 KEY NAMES AND TITLE PAGES 

DataLink dynamically updates special key name entries in your Title Page.  When the page is 

displayed on output, information drawn from an external data source is substituted for the key 

name.  (The external data is formatted with the current attributes assigned to the key name). 

You could think of DataLink this way:  the Data portion of the name refers to external 

information (data) expressed as a ‘key-value pair’.   

The data is thus formatted as follows: 

(key name) = (value assigned) 

Here is a typical key-value pair:  

current temp = 75° F  

 

The Link part of DataLink reflects the fact that key entries in your title pages are linked to 

matching data from the key-value pairs.  To provide dynamic updates in this manner, DataLink 

operates quietly in the background, patiently monitoring external sources for changes.   

As mentioned earlier, three special DataLink components monitor specific external sources.  

These are the Scoreboard Linker, TXT Linker, and Database Linker. Let’s consider these modules 

individually in more depth now. 
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4.1.2 SCOREBOARD LINKER 

  
This Linker receives data from an external hardware scoreboard controller such 
as a Daktronics™ system.  The external system provides information to DataLink 
by a physical COM port connection. (Section 4.3, Connecting External Devices, 
explains how to connect these devices so they can communicate with DataLink.) 

 
DataLink supports popular external devices from several different manufacturers. The 
Scoreboard Linker monitors the incoming data stream, and assigns specific values to unique 
DataLink key names.  These values are then substituted for the corresponding key name entries 
in title pages.  These special key names are listed by brand in Section 4.5.1.   

Note: As the data supplied by various external systems differs, DataLink uses unique key 

names for each supported brand.  As well, this arrangement permits devices from two 

(or more) manufacturers to be connected simultaneously without conflict. 

4.1.3 TXT AND DATABASE LINKERS 

 
These two Linkers each keep an eye on their namesake file types, refreshing the display as 
required, and serving many handy and creative purposes.  

Note: TXT Linker monitors files (.txt) you place in the folder Text Input. 

For example, a simple ASCII text file (.txt) containing a list of names (prepared as key-value pairs) 
could be used to automatically update a credits slate, or perhaps to populate the name fields in a 
series of individual lower thirds for a weekly production (Section 4.2.1 explains the details of this 
example). 
 
The TXT Linker continuously watches for changes in the values assigned to keys.  If a value 
changes in the file, the display is immediately updated.  Thus, third-party programs may be 
designed for various applications that continuously update the onscreen text display by changing 
values assigned to keys in the file. 
 
The Database Linker provides even more powerful possibilities.  It allows the use of supported 
MySQL database functions to derive replacement values for DataLink keys on the title page – 
even accessing the data across a network. 

Note: Database Linker monitors files (.txt) you place in the folder Database Input. 
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4.2 WORKING WITH KEYS AND VALUES 

In this section we’ll get into the details of working with DataLink for your live productions. We’ll 

explain how to add DataLink key names to your title pages, and how these may be used in 

various ways. The quickest way to become familiar with DataLink is to dive right in and try it out. 

4.2.1 TXT LINKER 

As discussed back in Section 4.1, DataLink’s TXT Linker pulls data from ASCII text files (.txt) 

residing in a specific (constantly monitored) folder. As this is arguably the simplest source 

available to DataLink, let’s begin by using it to demonstrate a few basics before continuing. 

This monitored folder location varies depending on your operating system.  The simplest way to 

find it is to use a shortcut in the Windows™ Start menu.   Click Start, then the Programs link, and 

locate the NewTek>LiveText>DataLink folder.  Click the folder icon inside that labeled Open File 

Observer Folder. 

 

Figure 49 

By default, this folder contains just one file, named fileobserver example.txt (Figure 49).   

1. Double-click the text file icon to open it in your default text editor. 
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 To supply usable values for DataLink, text files should contain nothing other than key-value 

pairs, arranged in the following format: 

[key] = [value] 

Key names from the file(s) will be available as DataLink entries in your LiveText title pages.  The 

value you enter beside the key name in the text file is the actual information that will be shown 

when the page is displayed on output. 

The sample file currently contains just one key-value pair, as follows:  “version = 2.0”.   

Note: Both keys and values may contain punctuation and spaces. 

2. Launch LiveText, if it’s not already running. Note that you can move back and forth 

between the text editor (with the sample file loaded) and the LiveText window by 

pressing Alt + Tab on your keyboard. 

 

3. Click the Text [T] tool button, click somewhere on the empty Canvas, and type “My 

current LiveText version is:" 

 

4. Left-click outside that text object (to complete it), then move over to the right a bit and 

press the right mouse button.  This will open a drop-down menu (Figure 50). 

 

 

Figure 50 
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5. Select Version from the list, and release the mouse button. 

 

 

Figure 51 

6. A new object is created containing the text %Version%.  This is how a DataLink key 

appears on the canvas in Text edit mode (bracketed between percentage signs). 

The keyword “Version” was listed in the menu because it has been defined in fileobserver 

example.txt, as we noted previously.  Likewise, a value is assigned to “version” in that ASCII 

text file.  Let’s see how LiveText displays that value. 

7. Click the Select (Arrow) button in LiveText’s tool panel. The “version” key is immediately 

replaced by “2.0”, the value currently assigned to that key in the text file. 

 

 

Figure 52 

8. Press Alt + Tab on your keyboard to switch back to the text editor.  (If necessary, move 

it a bit to one side on the screen so you can see”2.0“on the LiveText canvas.) 

 

9. Change the value assigned to “version” in the text file to “10”, then pull down the File 

menu (in the text editor) and select Save.   

As soon as you save the change to the text file, LiveText refreshes its display as well. 

10. On a new line (below the “version = 10” line in the text file), type: 

 

developer = NewTek 

 

11. Re-save the text file. 
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12. Now, click the Text [T] tool in LiveText.  Right-click on the canvas, and notice that a new 

item appears in the drop-down menu options – “developer”. 

Let’s try something slightly different. 

13. Press Alt + Tab to bring the text editor forward again, and delete all of the text in the file 

(don’t save the file, though). 

 

14. Enter a new line of text as follows (enter your personal name for your name): 

My Name = your name 

 

15. Select Save As from the File menu, and save the file using the file name Names.txt, then 

right-click on the canvas again – notice that “My Name” appears in the menu option list, 

even though it’s in a different text file.  TXT Linker watches for changes in all suitable 

files located in the observed folder. 

Experiment with TXT Linker a bit more: 

 Try applying a Style to DataLink key objects. 

 

 Click the Layers tab, and double-click on a DataLink object name.  Notice that this allows 

you to type in a custom name for the object.  Press Enter on the keyboard to complete 

the operation; naming the layer does not modify the object on the canvas. 

 

 Type a sentence in a new text object, then right-click between words in the sentence to 

insert a DataLink key into it – right in the middle of another text object (or select the 

characters of a word, and repeat the exercise to replace them with a DataLink key. 

Let’s briefly consider one (slightly more elaborate example) using the TXT Linker: 
 
Suppose you regularly produce a half-time show featuring interviews with 8 to 10 different 
guests.  You could create a LiveText project with 10 pages, and manually modify each page 
before every episode.   
 
Or, you could prepare the pages once, and let DataLink update them all for you automatically 
every time!  To do that, you could proceed as follows: 
 

1. Prepare a simple text file similar to this one: 
 
guest1 = Bill E. Bob 
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guest2 = Sam Houston 
guest3 = Dorothy Lamour 
 … etc. 
 

2. Go to the Add Pages drop-down menu in LiveText, and select a nice-looking lower third 
template (or make your own if you prefer). 
 

3.  Where the guest’s name should appear, place the DataLink key “%guest1%”. 

Note: You may find it faster at times to directly type the key name on the canvas 

(between percentage signs) rather than using the drop-down menu.  Either method will 

work just fine. 

4. Clone the page as many times as necessary 
 

5. Click the second thumbnail (no need to edit the first one) in the Pages column at right to 
select it for modification, and click the [T] button (to activate text entry). 
 

6. Click in the DataLink key field on the canvas, and replace %guest1% with %guest2% 
Note that  
 

7. Click the next page, and change the key to %guest3%, and so-on, until all done. 
 

That’s all you need to do.  Before each episode, have your production assistant take a few 

moments to update the guest.txt file content, and the hard part is done. Afterward, simply load 

the LiveText project you created – each successive page automatically displays the correct name 

in sequence when displayed. 

The other two DataLink modules (Scoreboard Linker and Database Linker) reference different 

data sources, but the process of creating title pages with DataLink key names is exactly the same 

as we have reviewed above. 

Let’s go on to consider the Scoreboard Linker.  Unlike the other two modules, DataLink depends 

on an external hardware connection to supply values for these keys.  In the next section, we’ll 

explain how to connect these external devises. 
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4.3 CONNECTING EXTERNAL DEVICES 

THE STEPS IN THIS SECTION ARE MANDATORY IF YOUR INSTALLATION REQUIRES DATA FROM AN 

EXTERNAL DEVICE (SUCH AS A DAKTRONICS™ OR COMPARABLE SCOREBOARD SYSTEM). 

Naturally, for DataLink to communicate with an external data source, that 

equipment must be connected to the LiveText host system and powered up.  As well, DataLink 

must be configured to find and use the connection.  We’ll discuss how to make and configure 

connections under this heading. 

4.3.1 USB-SERIAL ADAPTERS 

The diversity of supported external systems, cable connectors, 

and available ports on the host system means this connection 

may require an adapter. Newer external devices may use USB 

connections, but others use older RS-232 (25-pin) connectors, 

or occasionally (slightly more recent) 9-pin style connectors. 

Unless the external system is supplied with a USB connection, a 

USB-Serial adapter is likely required to connect it to a host 

systems with newer motherboards). 

To connect using a USB-Serial adapter, follow these steps: 

1. Connect the scoreboard controller’s output cable connector to the USB-Serial adapter. 
 
a. Plug the adapter into the LiveText host system. 

 
b. Install drivers for your USB-Serial adapter on the host system.  Drivers for the adapter 

are generally supplied on a Compact Disk (CD) packaged with the adapter by the 
manufacturer. Unless these drivers are correctly installed, DataLink cannot receive data 
from the external controller.  (Carefully follow the instructions provided by the 
manufacturer of the adapter you purchased). 

 

4.3.2 FIND THE COM PORT 

 
The next step involves determining which COM port the operating system has assigned to the 
new connection.  This information is required to configure DataLink. 
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2. Right-click the My Computer icon on the Windows Desktop, and select Manage from the 

menu (to open the Computer Management panel). 
 

3. Open the Device Manager (Figure 53) by clicking that entry in the left-hand pane of this 
window. 
 

4. Click the + sign next to Ports (COM and LPT) in the right-hand pane to disclose available 
communication ports. 
 

5. Locate the entry for your scoreboard controller – take note of which COM port number is 
assigned to it (such as COM 1 or COM2). 
 

 

Figure 53 - Device Manager 
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Note - you should see your new connection listed, as in Figure 53. If it doesn’t appear at first, 

try removing and re-inserting the USB cable connector – or you can use the “Scan for 

hardware changes” item in the Device Manager’s Action menu. 

 

(If it does appear, but shows a ! icon next to the entry, this may indicate a problem with the 

USB connection or your adapter driver installation – try re-installing the adapter driver, 

following the directions supplied with it.) 

6. Close the Device Manager. 
 

Again, the port number you noted above is required to enable DataLink to recognize the external 
device.  The next heading explains how to configure DataLink to access this source and the 
stream of information it provides. 
 

4.4 CONFIGURE DATALINK 

THE STEPS IN THIS SECTION ARE MANDATORY IF YOUR INSTALLATION REQUIRES DATA FROM AN 

EXTERNAL DEVICE (SUCH AS A DAKTRONICS™ OR COMPARABLE SCOREBOARD SYSTEM). 

 

Assuming you followed the steps listed in Section 4.3 (Connecting External Devices), there’s one 

more thing to do before DataLink can communicate with an external device.  You need to tell 

DataLink which COM Port(s) it should listen to. 

1. Click the Windows Start menu, and go to Programs. 
 

2. Select Programs>NewTek>LiveText>Configure Scoreboard (this will open the file 
Scoreboard.ini in a text editor, allowing you to modify it). 
 

3. Locate the section (of the .ini file) appropriate for the brand of scoreboard controller you 
connected. 
 
 Note: DataLink currently supports 4 different brands of external devices, namely 
Daktronics™, Whiteway™, DSI™, and OES™. 
 

4. Change the value for Port in the connected device brand’s section to correspond to the Port 
number you noted earlier in Section 4.3.2 (enter Port=1 if the device was found at COM1, 
and so on). 

 
5. Change the value for Enabled in the appropriate brand’s section to 1 (from 0).  For any and 
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all brands of controller that are not connected, Enabled should be set to 0. 
 
Note that it is possible to connect more than one controller brand simultaneously.  In this 
instance, enter Enabled=1 and the corresponding Port number for each connected controller 
in the Scoreboard.ini file. 

 
6. Save the Scoreboard.ini file, and Exit the text editor. 

Important Note: In some environments, Windows may arbitrarily reassign the external 

device to a different COM port following a reboot.  If this happens, you could simply update 

the COM port entry in the .ini file.  However, you may prefer instead to lock the connected 

device to a specific COM port, using the Windows Device Manager. 

To do this, please locate the current port entry for your scoreboard controller.  Right-click the 

entry name, and select Properties in the drop-down menu. 

Next, click the Port Settings tab at the top of the Properties panel, and click the button 

labeled “Advanced”. Use the Com Port Number drop-down menu to choose an unused port 

number, and click the OK button.  OK the Properties panel too, then close the Device 

Manager.  The Port Number you assigned should now be retained on subsequent reboots.   

At this point, DataLink is ready to utilize information from the scoreboard controller. 
 

4.5 SCOREBOARD LINKER 

As must be clear by now, this DataLink component receives data from an 

external scoreboard hardware controller, such as a Daktronics™ unit. 

 

We explained how to connect these external devices to the host system in Section 4.3, 

Connecting External Devices.   If you have a supported device successfully connected and 

configured, LiveText’s drop-down key insertion menu will now list valid key names for that 

specific brand of device. 

4.5.1 KEY NAME LIST 

This section lists the actual key names that are available for use with DataLink and the different 

brands of external equipment it supports. 
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Mostly, the key names are self-explanatory, but we’ve added slightly more descriptive notes 

anyway.  Here’s the complete current list, grouped by manufacturer.  

Note: the key names listed are shown inserted between percent (%) signs as a 

reminder, since this is how you will enter them onto your pages. 

DAKTRONICS KEYS: 

%DakClock%  - Game Clock Time – “MM:SS.T” 

%DakClockStatus% -  Game Clock Status 

%DakShotClock%  -  Shot Clock Time – “SS“ 

%DakHomeScore% -  Home Team Score 

%DakAwayScore% -  Guest Team Score 

%DakHomeFouls% -  Home Team Fouls 

%DakAwayFouls% -  Guest Team Fouls 

%DakHomeTOFull% - Home Time Outs Left – Full 

%DakHomeTOPart%  - Home Time Outs Left – Partial 

%DakHomeTOTotal%  -  Home Time Outs Left – Total 

%DakAwayTOFull% - Guest Time Outs Left – Full 

%DakAwayTOPart% - Guest Time Outs Left – Partial 

%DakAwayTOTotal%  -  Guest Time Outs Left – Total 

%DakPeriod%  - Current period 

%DakHhr%  - Hour (from Clock Time) 

%DakMin%  - Minutes (from Clock Time) 

%DakSec%  - Seconds (from Clock Time) 
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%DakTen%  - Tenths (secs/10 from Clock Time) 

WHITEWAY KEYS: 

%WWPeriod%   - Current period 

%WWMin%   - Minutes (from Clock Time) 

%WWSec%   - Seconds (from Clock Time) 

%WWTen%   - Tenths (secs/10 from Clock Time) 

%WWAwayScore%  -  Guest Team Score 

%WWHomeScore%  -  Home Team Score 

%WWShotClock% -  Shot Clock Time 

%WWClock%   -  Game Clock Time – “MM:SS.T” 

DSI KEYS: 

%DSIClock%   -  Game Clock Time – “MM:SS.T” 

%DSIShotClock%   -  Shot Clock Time 

OES KEYS: 

%OESClock%   -  Game Clock Time – “MM:SS.T” 

%OESShotClock%  -  Shot Clock Time 

%OESAwayScore%  -  Guest Team Score  

%OESHomeScore%  -  Home Team Score 

%OESHomeFouls%  -  Home Team Fouls  

%OESAwayFouls% -  Guest Team Fouls 

%OESHomeTO%  -  Home Team Time Out 
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%OESAwayTO%  -  Guest Team Time Out 

%OESPeriod% -  Current period 
 

4.6 DATABASE LINKER 

Like the TXT Linker, this component monitors an external file for keys (and changes to the 

corresponding values).  In this case, though, it accesses a more complex and powerful file 

structure – the database. 

This allows users to take advantage of supported MySQL database query functions to derive 

replacement values for the keys on the text page.   

Hint: If you plan to use this feature, you (or someone helping you) will need a measure of 

familiarity with database queries. 

In this case, DataLink monitors the folder Database Input, located inside the Stats Plugins folder 

(which you can find, as before, using the NewTek>LiveText>DataLink section of the Windows 

Start menu).   

The database file itself doesn’t need to be located in this folder, however.  Rather, a special .xml 

type file goes here.  In turn, the XML file content provides the information that DataLink needs in 

order to access the external database values.  Here’s a sample xml file: 

<!— 

 Example connection string and query for DataLink using MySQL. 

 This produces the keys %book.1%, %book.2%... etc 

--> 

 

<sql_databases> 

 

    <database connection_string = "Driver={MySQL ODBC 3.51 Driver}; 

Server=localhost; user=root;password=my_password; database=book_table"> 

 

        <query> 

            command = "SELECT title FROM Books;" 

            key = "book" 

            timeout = "10000" 

            multiple_keys = "true" 

        </query> 

 

    </database> 

</sql_databases> 
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Replacing the Server, user, password, etc. values with the correct ones for your environment 

permits the Database Linker to supply values to DataLink keys as described in the commented 

lines listed at the top of the file (i.e., an array in the format book.1, book.2, and so on). 

With respect to the line that states timeout = “10000” in the xml file – this tells DataLink to how 

often (in milliseconds) to update its values from the database.  Lower values result a faster 

refresh rate.  (Rates that are overly high are undesirable as the data may not seem to be updated 

in a timely manner). 

The multiple_keys = “true” entry tells DataLink that more than one match to the SQL query is 

acceptable. In this case, DataLink will create a key/value pair for each qualified result.  For 

example, a keyword “author” could produce an array of matches, which DataLink would arrange 

as follows: 

%author% -> "Voltaire" 

%author.1% -> "James Joyce" 

%author.2% -> "Herman Melville" 

 

4.7 CONTROL KEYS 

LiveText’s DataLink tools provide still further possibilities. Several special keys called control keys 

effectively permit you to drive LiveText output externally (beyond merely altering the value of a 

text string). 

4.7.1 PAGE CONTROL KEYS 

For example, control keys permit you to replace a photo embedded in a title page (even while it 

is displayed live), or change the title page currently displayed, and additionally (if it is an 

animated scroll or crawl) play or stop it.  The principal control keys are LiveText_PageNo and 

LiveText_Play. 

As you would expect, simply changing the numeric value assigned to the key LiveText_PageNo 

causes the corresponding page in LiveText’s Pages list to be sent to Live output.  The control key 

LiveText_Play accepts either of two different values – 1 or 0. Assigning the first causes an 

animated page to play, whereas assigning 0 (zero) to LiveText_Play stops playback. 
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4.7.2 IMAGE CONTROL KEYS 

Custom control keys governing image file references in title pages can also be created.  These 
keys and corresponding values are defined in either ascii files or by a database query (see 
sections 4.2.1 and 4.6). 
 
This works as follows: 
 

 Assign a custom control key name and value that can be detected by either the TXT 
Linker or Database Linker, as discussed earlier – let’s say you that a key named 
mytitlepic01 is given the value D:\PlayerPics\Joe Gamestar.jpg.  In this case, as you can 
see, the value is the full file path for a specific image. 
 

 In LiveText, add an image to the current page (in the canvas pane), right-click it, and 
select the key “mytitlepic01” from the drop-down menu – just as you would assign any 
DataLink key to an object. 

 
That’s all that’s required to configure the page for realtime image updates.  Afterward, whenever 
the Database Linker module returns a new value for mytitlepic01, the image displayed in the title 
page will automatically be updated.  For example, if the value for mytitlepic01 is changed to 
D:\PlayerPics\Suzy Q. Champion.jpg, that new file will immediately replace Joe Gamestar.jpg.  
 
Many of the default title page templates pages supplied with LiveText have stand-in (or 
‘placeholder’) images all ready for you to replace with imagery of your own.  These too can have 
image keys assigned to them.  If you look at the entry for a stand-in image in LiveText’s Layers 
tab, you can determine which of the several default files is used in a given title page. 
 
You may find it useful to note the resolution for those images (to prepare images that will fit 
perfectly).  The file resolutions for the common placeholder images in LiveText 2 are as follows: 
 

 PLandscape_placeholder.png (936x586) 

 PLargePortrait_placeholder.png (521x578) 

 Portrait_placeholder.png (406x441) 
 

4.8 LIVETIME™  

Whether or not you have an external scoreboard system connected (and regardless of whether 

you are using TXT Linker or Database Linker or not), a number of time-related options appear in 

LiveText’s key insertion drop-down menu.  Examples of these key names are Time, Date, and 

variants on these – such as Date (YYYY). 
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These keys are courtesy of LiveTime which allows you to place clock and date objects that are 

updated in realtime on your title pages.  When LiveTime keys are displayed, the corresponding 

values are derived from the LiveText host’s system clock.  This provides many useful and creative 

possibilities.
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5 LIVE PRODUCTION AND FILE MANAGEMENT 

 

 
Title pages and projects created in LiveText can be utilized in a surprising 
number of ways. Going ‘direct to air’ in a live production is amazing 
enough, but there are also many other benefits to LiveText, too! 
 
This chapter explores the options available, whether in connection with 
immediate live display or for other purposes.  As well, it explains the 
many convenient and useful features available in LiveText’s file 
windows. 
 
 

 
 
LiveText output is immediately available for display in live productions using network-connected 
live production systems such as NewTek’s TriCaster.  Too, individual LiveText pages can be 
exported as image or animations files, and used in various ways. 
 

5.1 LIVE DISPLAY 

Once a network connection exists between the 

LiveText workstation and live production 

system (see Section 2.3, Making the 

Connection) ‘going live’ is a simple matter. 

Click the large red Live button (beside the Live 

Output display in the upper-right corner) 

outputs the currently selected title page to the 

network as a source. 

The person controlling the connected live 

production system then selects the LiveText 

entry from the list of available sources.   

Figure 54 
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         Figure 55 – TriCaster Studio External Tab with LiveText source selected 

Hint: When the LiveText output is selected in the External panel of the live production 

system, the status line (above the Live Output preview) says “Connected.” 

 

Once assigned as the currently active External source, the LiveText page can be displayed as part 

of the live production by selecting either the EXT (or Net) button on a Switcher row, or the 

similar button in the Overlay section. 

You can use Add Page or edit other title pages in the 

Canvas even when a LiveText page is displayed on the 

networked live broadcast system.  The Live Output is 

normally only updated when you click Live again.  There is 

another way to select the Live Output page, though: 

Double-clicking a thumbnail image in the Pages panel 

sends it immediately to Live Output.  (When you do this, 

the designated page is added to both the Canvas and the 

Live Output preview.) 

 

 

Hint: The thumbnail icon for the Live Output page is outlined in red, and the thumbnail 

for the page you are editing is outlined in white. 

 

Figure 56 
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If the current page is animated – i.e., a 

(vertical) Scroll or (horizontal) Crawl - the 

transport controls beneath the preview 

pane are activated. 

Click the right-most (>) button to 

commence Play, the center button (||) to 

Pause (or resume play when already 

paused), and the first button (|<) to go to 

the beginning of the animated page. 

Hint: Conveniently, LiveText automatically 

begins scroll and crawl animation on a 

blank frame. 

 

The number of the current Live Output page is shown in a field to the right of the Play button.  

You can use the nearby arrow buttons to move backward and forward through the list of pages, 

or jump to a specific page by entering its number and pressing the Enter key. 

Note: The forward/backward buttons and direct numeric entry controls are disabled if an 

animated page is either playing or paused. 

 

5.2 FILE EXPORTS 

LiveText pages exported as bitmap format files (.png, .avi) can be used creatively in the DDR and 

Picture modules of compatible live broadcast systems (such as TriCaster). 

LiveText also exports Title Page files (.cgxml) for use in the Media Players (DDR, Stills, Titles) 

found in the Live Desktop of TriCaster TCXD series systems. 

Image and animated pages (both bitmap and .cg formats) exported from LiveText can also be 

used in connection with SpeedEDIT 2 video editing projects. 

Figure 57 
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CGXML Title Page Notes:  The Title Page format (.cgxml) used by TriCaster TCXD series 

systems presently supports almost every attribute that LiveText offers – but there are a 

few exceptions. 

For example, multiple font properties on one text line are not supported, which means in 

turn that different words on a single line cannot be different colors, or use different 

typefaces.  Of course you can achieve the same effect by using additional text objects as 

necessary. (For similar reasons, text entered as paragraphs is automatically split into 

multiple lines in .cgxml Title Page files.) 

5.2.1 FILE MENU 

 

 

The File menu is in the upper left corner of the LiveText desktop.  It contains project and page file 

management tools.  Projects and (editable pages) are stored as *.cg files.   

Choosing New clears the current project, and opens a new blank one. (LiveText’s custom file 

explorer is discussed in detail shortly, in Section 5.3). 

Open also clears the current project, replacing it with another a .cg file (a LiveText project) you 

have previously created and saved (see the note in Section 3.3 re: legacy LiveText projects). 

Figure 58 
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5.2.1.1 ADD FILES (IMPORTING) 

Add Files can be used to add an image or even a text file (see below) to the current LiveText 

page.  Alternatively, you can change the file suffix in the file requester to show files ending in 

“.txt”. 

This permits you to import long lists of textual data prepared in standard ASCII text format and 

saved as a .txt file.  This feature will be discussed a bit later, in Section 5.3.1.6. 

Note: You may find it preferable to add files using the Layers tab (discussed next) to drag 

files onto the Canvas. 

 

5.2.1.2  PROJECT (SAVE AS) 

Save the current project with all of its component pages as a LiveText project file (.cg).  Saved 

files may be reloaded later of course, and may also be compatible with selected CG applications 

in the NewTek family. 

This latter option opens up possibilities similar to those discussed next under Export Current 

Page. 

 

5.2.1.3 EXPORT CURRENT PAGE 

Export Current Page can export a single CG Page (.cg is LiveText’s project file format), convert 

the highlighted page into a Still Image file format (.png file format), or a Title Page file (.cgxml) 

for live production use with TriCaster TCXD systems.  If the current page is a motion page (Scroll 

or Crawl), the options in the File Type are CG Page and Video for Windows (.avi) file format. 

You can choose common NTSC or PAL video resolutions when saving either still or animated files 

using the Resolution menu options. 

Exported page types (other than .cg) can be added to the playlist of a DDR module (or Picture 

module) on selected live production systems, and applied via the Overlay module; or you may 

use them in non-linear editing applications.  If the page(s) contain transparent areas, the 

transparency will be retained. 
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Figure 59 

Project files (.cg) can be imported into LiveText 2 compatible software, or re-loaded into 

LiveText. 

 

5.2.1.4 EXPORT ALL PAGES 

This export feature works much like Export Current Page. The primary difference is that all pages 

comprising the current project are exported. 

The Title Page (.cgxml) file export type does not support motion pages – hence if you choose that 

alternative, LiveText will automatically prepare .avi clips for any motion pages encountered as it 

exports the project pages. 

If the current page when you select Export Current Page is a still, the File Type menu offers 

export as Still Image (*.png).  Nevertheless, LiveText will again automatically prepare .avi clips for 

any motion pages encountered as it exports the project pages. 
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5.3 FILEBIN FEATURES 

LiveText features custom file browsing features used in connection with loading and saving 

various file types.  Two file browsers are provided – the one used in connection with File menu 

selections, and the main Filebin - a tabbed panel underneath LiveText’s Canvas and Motion 

Control pane. 

 

Figure 60 

For the most part, although the layout of the two file panes varies slightly, the features are quite 

similar, and you should quickly become comfortable with them. 

5.3.1.1 VIEW OPTIONS 

The largest part of either file browser is the file list window. In the default view (and several of 

the optional ones) you will see a large thumbnail image icon to represent any image file.   

 

Figure 61 
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This view can be personalized to suit your need or taste in several ways. 

 

 

 

 

A drop-down menu in the upper-right corner of the pane controls the appearance of items in the 

file list window.  By default this menu is set to Large Icon. You can use this menu to radically alter 

the appearance and features of the panel. Try the different view options out, and you’ll quickly 

see how they affect the display. 

The only view option that requires a little longer explanation is the Details view (Details Only is 

similar, but minus the file icon.) The Details view gives you a lot of in-depth information about 

your files. 

 

Figure 63 – Filebin tab, Details View 

 

5.3.1.2 NAVIGATION  

In standard fashion, double-click a folder or drive shown in the file list window to enter it, 

displaying its content. 

Figure 62 



 

61 

 

Figure 64 

Above the file list pane, a row of rectangular text boxes appears (Figure 64) as you navigate down 

into your directory structure.  These text boxes show the directory path of the current view. Click 

directly on a text box to jump back to that drive or folder location. 

 

Figure 65 

Nearby you will find buttons labeled Back and Forward (or triangular forward and back gadgets.)  

These work just like the similar features found in an internet web browser.  

THE HOTLIST 

If you have a folder you frequently access, you can add it to the Hotlist at the bottom of file 

windows. Navigate to the folder you want to add, and press the plus sign at the left corner (click 

the minus sign to remove the current Hotlist button.)  

 

Figure 66 

When you right-click directly on a Hotlist button, a two-item menu pops up.  You can Remove 

the selected entry, or Rename it.  The Rename option creates a ‘nickname’ for the current folder, 

and refreshes the Hotlist to display it. (If your list is wider than the bin, there is a scroll gadget 

lower right.) 

5.3.1.3 CUT, COPY, PASTE, DELETE 

Cut, Copy, Paste and Delete buttons are also located here.  These operate on the currently 

selected items in the file list window.   

Of course, the common keystroke shortcuts also work in the usual manner (CTR+c for 

Copy, CTRL+v for Paste, CTRL+x for Cut, and the DEL key to Delete a file.) 
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The New Folder button creates a new directory at the current level, and pops up a small dialog 

allowing you to change its name on creation.  Alternatively, you can create a New Folder from 

the menu that appears when you right-click in an empty spot in the file list window. 

5.3.1.4 FILE SELECTION 

As you’d expect, simply clicking a file in the file list window selects it.  If you click one file and 

then hold Shift down when you click another, you can select all the files in between.  Or, click 

multiple files (in any order) while holding down the CTRL key to select a number of files which are 

not next to each other in the file list. 

5.3.1.5 FILEBIN OPERATIONS 

The tabbed Filebin panel (under the Canvas) is unique in that it has no ‘add’ or ‘save’ (etc.) 

buttons.  Really, this Filebin is intended for quick and convenient interactive use. Simply drag a 

file onto the Canvas to load or import it.  When the file is a .cg file, the current LiveText project 

will be completely replaced by the import.  On the other hand, if you drag an image file into the 

Canvas, it is added to the current page.  

Text files (in standard ASCII .txt format) are a special case.  Dragging a text file onto the Canvas 

(or importing one using the File menu) triggers a powerful feature, described next. 

5.3.1.6 IMPORT TEXT 

If you drag an (ASCII) file onto the 

Canvas from the tabbed Filebin, the 

Import Text panel pops up.  

This panel offers numerous controls 

over the manner in which the lines of 

text in the file are treated on import, 

and how multiple pages will be 

generated as necessary for them. 

You can create a new page for each line of text, or form a single long page containing multiple 

lines.  As well, you can control placement of the text on the newly created page(s) using the 

Alignment, Preset or Custom Position buttons.

Figure 67 
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6 APPENDIX A –  KEYBOARD SHORTCUTS 

 

Show Keyboard Shortcuts F1 

6.1.1.1 FONT 

 

Font Name (next/previous) F5  (Shift +) 

Font Size F6  (Shift +) 

Font Rotation F7  (Shift +) 

Font Tracking (Spacing) F8  (Shift +)  

6.1.1.2 TEXT 

 

Increase/decrease Width by 5 pixels Alt w  (Shift +) 

Increase/decrease Height by 5 pixel Alt h  (Shift +) 

Increase/decrease Edge by 1 pixel Alt k  (Shift +) 

Increase/decrease Italic by 1 pixel Alt i  (Shift +) 

Increase/decrease Tracking by 1 pixel Alt space  (Shift +) 

Next/Previous Font Alt f  (Shift +) 
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6.1.1.3 CLIPBOARD 

 

Select All Ctrl a 

Deselect All Ctrl d 

Cut Ctrl x 

Copy Ctrl c 

Paste Ctrl v 

Delete Del 

Redo Ctrl y 

  

Undo Ctrl z 

6.1.1.4 TEXT TOOL 

 

Select One character Shift + L/R Arrow 

Move curser to beginning  Home 

Move curser to end End 

Select to the beginning Shift + Home 
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Select to the end Shift + End 

Delete entire trailing word Ctrl + Delete 

Select entire line Shift + Up/Down Arrow 

Kerning by letter Alt + L/R Arrow 

Move and scale LMB (Left Mouse Button) 

6.1.1.5 MODIFY TOOL 

 

Rotate and Spacing LMB + Shift 

Multi-Select by area LMB + Drag 

Multi-Select Individual Objects LMB + Ctrl 

Nudge Up 1 pixel Up Arrow 

Nudge Down 1 pixel Down Arrow 

Nudge Left 1 pixel Left Arrow 

Nudge Right 1 pixel Right Arrow 

Nudge Up 10 pixels Shift + Up Arrow 
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Nudge Down 10 pixels Shift + Down Arrow 

Nudge Left 10 pixels Shift + Left Arrow 

Nudge Right 10 pixels Shift + Right Arrow 

6.1.1.6 ALIGNMENT 

 

Left Safety Alt l 

Center Safety Alignment Alt c 

Right Safety Alt r 

Bottom Safety Alignment Alt b 

6.1.1.7 LAYOUT 

 

Align Left Alt Shift l 

Align Alt Shift r 

Align Top Alt Shift t 

Align Bottom   Alt Shift b 

Align Horizontal Center Alt Shift c 
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Align Vertical Center Alt Shift v 

6.1.1.8 PAGE 

 

Add a new page Ctrl Insert 

Delete Current Page Ctrl Shift Delete 

Clone Current Page Ctrl Shift Insert 

Move up the Page list PageUp 

Move down the Page list PageDown 

Move to top of Page list Ctrl PageUp 

Move to bottom of Page list Ctrl PageDown 

6.1.1.9 SHADOW 

Add (Sub) 1 to Shadow Offset X Alt x  (Shift +) 

Add (Sub) 1 to Shadow Offset y Alt y  (Shift +) 

Shadow Type (up/down) Alt F5  (Shift +) 

Shadow Size (raise/lower) Alt F6  (Shift +) 
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Shadow Angle (raise/lower) Alt F7  (Shift +) 

Shadow Softness (raise/lower) Alt F8  (Shift +) 

6.1.1.10 EDGE 

 

Edge Type (up/down) Ctrl F5 (Shift +) 

Edge Size (raise/lower) Ctrl F6 (Shift +) 

6.1.1.11 VIEW 

 

Toggle Safe Area on and off Alt s 

6.1.1.12 FILES/FILEBIN… 

 

Open Ctrl + O 

Save Ctrl + S 

Save As Ctrl + Shift + S 

Add Files Alt + Insert 

Back Backspace 

Forward  Shift + Backspace 
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Selection…  

Select All Ctrl + A 

Deselect All  Ctrl + Shift + A 

First Item Home 

Last Item End 

Previous Item Left/Up Arrow 

Next Item Right/Down Arrow 

Previous Item and Keep Current Selection Ctrl + Left/Up 

Next Item and Keep Current Selection Ctrl + Right/Down 

First Item and Keep Current Selection Ctrl + Home 

Last Item and Keep Current Selection Ctrl + End 

Select All Previous Items Shift + Home 

Select All Previous and Keep Current Selection Ctrl + Shift + Home 

Select All Following Items Shift + End 

Select All Following and Keep Current Selection Ctrl + Shift + End 
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6.1.1.13 LIVE 

 

Send current page to live F9 

Play current live motion page (toggles play and pause) F10 

Pause current live motion page F11 

Stop current live motion page F12 
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7 APPENDIX B –  NETWORKING NOTES 

 

Clearly, a reliable and competent network connection must exist for your LiveText workstation’s 

output to be displayed live using a compatible live production system.  Any issue that impedes a 

good connection will likewise impede or even preclude the use of LiveText along with a live 

production system such as TriCaster or VT[5]. 

Reading this section will not turn you into a network guru, but it will assist you to diagnose some 

simple issues.  

7.1 PING IS YOUR FRIEND 

 

More complex problems may require you to 

turn to the system administrator for help -- but 

you may be able to resolve simpler issues by 

borrowing one of the IT Departments secret 

weapons! 

Ping is a humble but effective (and free!) tool to 

confirm that the requisite connection exists.  A 

standard inclusion in operating systems, Ping 

may help you diagnose LiveText connection 

issues. 

Ping sends a small set of data packets to the target host (IP number), then ‘listens’ for an echo 

response in return.  It estimates the round-trip time in milliseconds, records any data losses, and 

displays a summary when finished. Bottom line, if you can’t ping your target, your connection has 

problems (the problem might be as simple as a bad cable connection.) 

Figure 68 

http://en.wikipedia.org/wiki/Packet_%28information_technology%29
http://en.wikipedia.org/wiki/Round-trip_time
http://en.wikipedia.org/wiki/Milliseconds
http://en.wikipedia.org/wiki/Packet_loss
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Finding the target IP number: 

To issue a ping, you need know the IP number of the target computer. 

 On a Windows XP® system, you can find this number by: 

(On TriCaster, click the [x] button in the upper-right corner of the screen, and select 

Admin to get to the Windows Desktop.)  

Next, select Network Connections from the Windows Start Menu (look in the Settings 

sub-menu if it is not listed at the top level.) 

 

Inside the Network Connections panel, right-click on the icon for your LAN (local Area 

Network) and select Status.  The IP Address for the system is shown on the Support tab. 

Issuing a Ping 

Ping is a command line program, and must be run from a command shell on the issuing 

computer. To open a command shell and send a ping, follow the procedure below that applies. 

Windows 

 On TriCaster, click the [x] button in the upper-right corner of the screen, and select 

Admin to get to the Windows Desktop. 

 For all Windows XP® systems (including TriCaster) select  the Windows Start Menu 

command Run  

 Type “CMD” (without quotation marks) into the Run dialog panel 

 Press your Enter key a command shell window will open.) 

 Type “Ping” (without quotes) followed by a space and the target IP number, as in the 

image below – then press Enter. 

 

 

Figure 69 

 Ping will go to work, and in a moment or two begin reporting results.  A ping failure 

(indicating a network problem) will look like Figure 70.   
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Figure 70 

 A successful ping will display a report like Figure 71. 

 

 

Figure 71 
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Shadows, 12, 29, 67, 68 

W 

Windows 

Color Picker, 22, 29 



 

77 

9 CREDITS 

 

Acknowledgments: Tim Jenison, Jim Plant 
 

Engineering:  Andrew Cross, Kevin Rouviere, Nathan Kovner, James Killian, Kirk Morger, 
Brian Brice, Kevin Nations, Jeremy Wiseman, Masaaki Konno, John Perkins, Mike 
Watkins, Kenneth Long, Bennie Pierce, Cary Tetrick, Alvaro Suarez, Steve Bowie, Charles 
Steinkuehler, Menghua Wang, Shawn Wisniewski, Bob Peene, Greg Heine, Dan Fletcher, 
Anthony Louviere, Jan Uribe 
 
Additional thanks to: NewTek Marketing 

NewTek Content Development 
NewTek Technical Support 
NewTek Customer Service 
NewTek Sales 

This product uses the FreeImage library. This is licensed under the LGPL license (see link below).  

For the source, and the ability to change and recompile this component, please visit : 

http://freeimage.sourceforge.net/  

 

This product uses the LAME library. This is licensed under the LGPL license (see link below).  

For the source, and the ability to change and recompile this component, please visit : 

http://lame.sourceforge.net/  

 

This product uses the FAAC library. This is licensed under the LGPL license (see link below).  

For the source, and the ability to change and recompile this component, please visit : 

http://www.audiocoding.com/  

 

This product uses the FFMPEG library. This is licensed under the LGPL license (see link below).  

For the source, and the ability to change and recompile this component, please visit : http://www.ffmpeg.org/  

 

For a copy of the LGPL licence, please visit : http://www.gnu.org/licenses/lgpl.html  

 

Portions use Microsoft Windows Media Technologies. Copyright (c)1999-2010 Microsoft Corporation. All Rights 

reserved.  

 

VST PlugIn Spec. by Steinberg Media Technologies GmbH.  

Copyright 2010 NewTek Inc., 5131 Beckwith Blvd. San Antonio, TX USA 78249.  TriCaster, VT[5], SpeedEDIT, 

LiveSet, LiveMatte, DataLink and LiveText are trademarks of NewTek Inc. HDV is a trademark of Sony Corporation 

and Victor Company of Japan, Limited (JVC) . All other brand names, product names, or trademarks belong to their 

respective holders.



 

78 

 


